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Welcome to scanning 
with HP PrecisionScan Pro and your 
HP ScanJet scanner

The scanning software and your HP ScanJet 
scanner let you quickly create excellent electronic 
images from pictures and convert text on paper 
into editable text.

Features

Some of the features of the scanning software are:
■ Click to select an image in the preview
■ Automatic sensing of output type
■ Automatic sensing of optimal exposure, color, 

black and white threshold, sharpen level, and 
resolution for images of pictures

■ Drag-and-drop the image to another program or 
to the desktop

■ Scale and size the image prior to exporting it to 
a program or a file

■ Return to the preview image without rescanning
■ Tools for adjusting exposure, color, black and 

white threshold, sharpen level, and resolution
■ Save and re-use scanning settings
■ Use HP PrecisionScan Pro scanning software and 

your HP ScanJet scanner on a local area 
network
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Microsoft is a U.S. registered trademark 
of Microsoft Corporation.

Windows is a trademark of Microsoft 
Corporation.

Acrobat® Reader Copyright © 1987-
1997 Adobe Systems Incorporated. All 
rights reserved. 

Adobe and Acrobat are trademarks of 
Adobe Systems Incorporated, which 
may be registered in certain 
jurisdictions.

FlashPix (portions) Copyright © 1996

wnload.
Book Contents Index

➮

➮

Support for your new 
product

No matter where you are or 
when you need it, HP support 
is there to help you get the 
most from your HP products. 
Whether it’s making products 
easier to use or providing you 
with innovative new ways to 
tackle your important projects, 
HP support helps you become 
a confident and creative user. 
If you do encounter a problem 
with your HP product, don’t 
worry. HP support delivers 
fast, accurate solutions that 
won’t rob you of either your 
product or your valuable time.

When you’re ready to get 
started, check out HP’s Web 
site,

http://www.scanjet.hp.com

for great ideas and quick tips 
on how to use your HP product 
in fun new ways.

© Hewlett-Packard Co., 1998. All Rights 
Reserved. Reproduction, adaptation, or 
translation without prior written 
permission is prohibited, except as 
allowed under the copyright laws.

RESTRICTED RIGHTS LEGEND
U.S. Government Restricted Rights. The 
Software and any accompanying 
documentation have been developed 
entirely at private expense. They are 
delivered and licensed as “commercial 
computer software” as defined in 
DFARS 252.227-7013 (Oct 1988), DFARS 
252.211-7015 (May 1991) or DFARS 
252.227-7014 (Jun 1995), as a 
“commercial item” as defined in FAR 
2.101(a), or as “Restricted computer 
software” as defined in FAR 52.227-19 
(Jun 1987) (or any equivalent agency 
regulation or contract clause), 
whichever is applicable. You have only 
those rights provided for such Software 
and any accompanying documentation 
by the applicable FAR or DFARS clause 
or the HP standard software agreement 
for the product involved.

First Edition, 1998
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How to use this online document

Go to the book contents, chapter contents, or 
index

■ Click the button in the yellow bar at the bottom 
of the page when the pointer looks like .

Page forward one page

■ Press Enter or PgDn, 
– or –

■ Click  in the yellow bar at the bottom of the 
page.

Page backward one page

■ Press Shift+Enter or PgUp,
– or –

■ Click  in the yellow bar at the bottom of the 
page.

Jump to a different part of the document

■ Click when the pointer looks like .

Undo a jump

■ Click  in the toolbar, 
– or –

■ Right-click to display the dropdown Acrobat 
Reader menu, then select Go Back.

Re-do a jum

■ Click  in 
– or –

■ Right-click t
Reader men

➮

➮
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an, the scanner light turns on 
across the bed. The charge-
ce (CCD) in the scanner records 
age of the light reflected from 
 you placed on the scanner bed. 
d image is made up of 600 
ch (ppi) and each pixel can have 
p to 36 bits.
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 an open document.
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What can you scan?

Using the scanning software, you can scan:
■ color photographs
■ color drawings and line art
■ grayscale drawings
■ black and white photographs
■ black and white drawings and line art
■ pages that have both pictures and text

During a sc
and moves 
couple devi
a digital im
the original
The recorde
pixels per in
a depth of u
The resultin
millions of 
An image is
program wh
as a file and
paste it into

H o w  s c a
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e has straight edges, place the 
t edges next to the top and right 

e scanner bed. This will make 
 image straight when you scan.
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Place the picture on the scanner

The picture you want to scan must be placed face 
down on the scanner glass.

1 Lift the 
scanner lid and 
hold it up.

2 Place the 
picture face
down on th
scanner gla

3 Close the 
scanner lid

If you are using the HP Automatic Document 

Feeder, see the online manual HP Automatic 
Document Feeder Guide.

A D F  u s e r s

If the pictur
top and righ
edges of th
the preview

T I P
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indows Start menu

, the Windows Start button.

s Start menu appears.
art menu, choose Programs, then 
canJet Software:HP PrecisionScan Pro.

canning software window appears, 
 does not automatically perform a 
n. 
eview scan:

e Preview button in the scanning 
ndow toolbar, or

ed to use the HP ScanJet Button 

configure the Scan button to set 
Scan Pro as the default software 
hen the Scan button is pushed 
2).
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Start the scanning software

There are three ways to start the scanning 
software:
■ push the Scan button on the scanner
■ use the Windows Start menu
■ launch the scanning software from another 

program using TWAIN (page 11)

Pushing the button on the scanner

1 Push the Scan button on the scanner once.

After the scanning software window appears, 
the scanner automatically performs a Preview 
scan and displays the preview image.

The Scan button is below the lid on the front of 
the scanner.

Using the W

1 Select 

The Window
2 From the St

choose HP S

When the s
the scanner
Preview sca

3 To start a Pr

■ click , th
software wi

Scan button

You may ne
Manager to 
HP Precision

to launch w
(see page 1

T I P
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n industry-standard 
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 to hardware (such as a scanner) 
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sing a program that supports 
 can start HP PrecisionScan Pro 
 that program. 

et scanners and HP scanning 
can use TWAIN, but the 
 you use to create projects may 
AIN-compatible.

am can use TWAIN, it should 
mmand named Acquire, Acquire 

Import on one of its main 
sually the File menu.
 one of these commands 
the scanning software selected 
elect Source command.
ext cannot be transferred using 

T W A I N ?
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■ from the Scan menu, select Preview, or
■ press Ctrl+R. 

The scanner performs a Preview scan and 
displays the preview image.

Launching from another program

If you are creating a project such as a greeting 
card or a calendar, and want to include a picture 
from a photograph, you might be able to scan the 
photograph directly into the program you are 
using. To do this, the program must have a TWAIN 
command such as Acquire, which is probably on 
one of its main menus.
1 Open the program in which you will place the 

scanned image.
2 If necessary, select the program’s Select Source 

command and choose HP PrecisionScan Pro.
3 Select the program’s TWAIN command.

After the scanning software window appears, 
the scanner automatically performs a Preview 
scan and displays the preview image.

4 Create a selection area in the preview image, 
make necessary adjustments, and select Place 

Image from the Scan menu. The final scan occurs 
and the image is placed in the calling program.

TWAIN is a
communica
instructions
and receivin
If you are u
TWAIN, you
directly from
■ HP ScanJ

software 
programs
not be TW

■ If a progr
have a co
Image, or 
menus, u

■ Selecting
launches 
with the S

■ Editable t
TWAIN.

W h a t  i s  
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cisionScan Pro in the list box.
, click the Enable the Scan button 
 place a checkmark in it.

Jet Button Manager window closes.
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Configure the Scan button

You can use the HP ScanJet Button Manager to 
configure the Scan button. It is set at the factory 
with HP PrecisionScan Pro as the default scanning 
software to launch when the Scan button is 
pushed.

1 Select , the Windows Start button.

The Windows Start menu appears.
2 From the Start menu, choose Programs, then 

choose HP ScanJet Software:HP ScanJet 

Utilities:HP ScanJet Button Manager.

The HP ScanJet Button Manager window appears.

3 Click HP Pre

4 If necessary
checkbox to

5 Click OK.

The HP Scan

Scan button

Download from Www.Somanuals.com. All Manuals Search And Do



�

the 
 software2

posure Adjustment tool

lor Adjustment tool

ack & White Threshold tool

nline Help

ve and re-use adjustment settings

t preferences

load.
2
➮

➮

A tour of 
scanning

14 Scanning software window 32 Ex

24 Context-sensitive pointers 33 Co

26 Image adjustment tools 34 Bl

27 Output Resolution tool 35 O

29 Sharpen Level tool 38 Sa

30 Dimensions tool 41 Se

Download from Www.Somanuals.com. All Manuals Search And Down



�

2 HP PrecisionScan Pro User’s Guide 14
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Scanning software window

This chapter describes the scanning software.
➊ Menus — The commands in the menus are 

summarized beginning on page 15.
➋ Toolbar — The toolbar has buttons for the 

most commonly used commands (see 
page 20).

➌ Preview area — The scanned image appears 
in the preview area of the scanning 
software window (see page 21).

➍  Info bar — Displays width and height of the 
output image, scale percentage, the Output 

Type currently selected, and Help button 
(see page 22).

➎ Status bar — Displays messages and 
approximate size of the selection area 
(Image Size) (see page 23).

Image adjustment tools — The scanning 
software has six tools for making 
adjustments to the image. These tools can 
be placed anywhere on the Windows 
desktop (see page 26).

Online Help — Help includes topics, What’s This, 
more online manuals, and videos (see 
page 35).

➊ Menu bar
➋ Toolbar

➌ Preview

➎ Status bar

area

Scanning software wi

➍ Info bar
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 at low resolution and displays 

ion area (see page 56).
s the selection area and saves 

 an image containing text or a 
F file (see page 93).
age to the TWAIN-compatible 

aving a set of scanning settings 

oading a set of saved scanning 

he selection area and sends the 

ting options for printing.
es dialog box for setting 
e page 41).
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Menus

All the commands for the scanning software are 
available in the menus. Each menu and its 
commands are described in the following tables.

Preview Ctrl+R Scans the entire area of the scanner glass
the preview image (see page 50).

Zoom Scans and enlarges the view of the select
Save As... Ctrl+S Displays the Save As dialog box, then scan

the image to a file (see page 100).
Save As Whole Page... Displays the Save As dialog box for saving

combination of text and pictures in an RT
Place Image Ctrl+I Scans the selection area and sends the im

program that called it (see page 11).
Save Settings... Displays the Save Settings dialog box for s

(see page 38).
Load Settings... Displays the Load Settings dialog box for l

settings (see page 40).
Print... Ctrl+P Displays the Print dialog box, then scans t

image to the printer (see page 96).
Print Setup... Displays the Print Setup dialog box for set
Preferences... Displays the HP PrecisionScan Pro Preferenc

preferences for the scanning software (se
Exit Closes the scanning software.

S c a n
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d copies it to the 
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Copy Ctrl+C Does a final scan of the selection area an
Clipboard for pasting into another progra

Select All Ctrl+A Draws a selection area that includes the e
scanner glass (see page 54).

Clear Selection Esc Removes the selection area (page 53).

E d i t

Toolbar When checked, shows the toolbar. When not checke
(see page 20).

Status Bar When checked, shows the status bar. When not che
bar (see page 23).

Info Bar When checked, shows the info bar. When not check
(see page 22).

Undo Zoom When viewing a zoomed image, displays the existin
you can create a different selection area without per
scan (see page 57).

V i e w
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lor Web Palette output 
 VGA colors 

hat contains pixel 

unformatted, editable 
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True Color Scans the selection in 24-bit color (see page 66).
Grayscale Scans the selection in 8-bit grayscale (see page 6

Black & White

Bitmap (raster) Scans the selection as a black and white raster im
Scalable (vector) Scans the selection as a black and white vector i

resized in another program without losing image
256 Color

Web Palette Scans the selection using colors from a standard
(see page 62).

System Palette Scans the selection using colors from the 256 Co

type palette plus more shades of gray and the 16
(see page 64).

Optimized Palette Scans the selection using colors from a palette t
colors present in the original (see page 63).

Text Scans a text selection and changes the text into 
ASCII text (see page 90).

O u t p u t  T y p e

Download from Www.Somanuals.com. All Manuals Search And Do



�

2 HP PrecisionScan Pro User’s Guide 18

tool, which sets the resolution 
27 and 83).

, which sets the amount of 
68).

hich contains fields for setting 
caling, and setting the width 
rinted, copied, or dragged and 

nt tool, which sets highlights, 
splays pixel distribution, pixel 
nd 70).

ool, which sets color balance 
 pages 33 and 80).

shold tool, which sets the 
e set to the Black & White 

 and 87).

mensions tool, to their optimal 

e for all output types.
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Output Resolution When checked, shows the Output Resolution 
for the final scan of the selection (see pages

Sharpen Level When checked, shows the Sharpen Level tool
sharpening for the image (see pages 29 and 

Dimensions When checked, shows the Dimensions tool, w
the width and height of the selection area, s
and height of the image that will be saved, p
dropped (see pages 30 and 58).

Exposure Adjustment When checked, shows the Exposure Adjustme

shadows, and midtones in the image, and di
color, and pixel output levels (see pages 32 a

Color Adjustment When checked, shows the Color Adjustment t
(hue) and color saturation in the image (see

B & W Threshold When checked, shows the Black & White Thre

threshold and the color channel for an imag
Bitmap (raster) output type (see pages 34, 85,

Reset Controls Resets the controls in all tools, except the Di

(default) values.

Not all tools are activ

T I P

T o o l s
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HP ScanJet Coach... Ctrl+W Explains the steps to scan
HP PrecisionScan Pro (see p

Contents and Index Displays the Help dialog b
and Find.

HP PrecisionScan Pro Help F1 Displays HP PrecisionScan

What’s This Help Shift+F1 Displays the What’s This H

getting Help by clicking on
or menu item (see page 3

Show Me Displays movies from the
CD-ROM that demonstrat
the scanning software (se

User’s Guide Displays the HP ScanJet P
User’s Guide in Acrobat R

ADF Guide Displays the HP ScanJet A
Feeder Guide in Acrobat R

About HP PrecisionScan Pro Displays the HP PrecisionS

version number.

Acrobat Reader was aut
during installation.

T I P

H e l p
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Toolbar

Frequently used commands appear as buttons in 
the toolbar.

Preview Scans the entire scanner glass and display
(see page 50).

Zoom Scans and enlarges the view of the selectio

Save As Scans and saves the selection to a file (see

Copy Scans and copies the selection to the Clipb

Undo Zoom Displays the existing preview image (see p

Reset Controls Resets the controls in all tools except the D
optimal (default) values.

Print Scans and prints the selection (see page 96

HP ScanJet Coach Displays an interactive introduction to scan

Help Topics Displays the What’s This Help pointer  fo
clicking on a tool, field, button, or menu ite

T o o l b a r  B u t t o n s
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e preview area determines how big 
plays. 

anning software window when you 
se the magnification of the view of a 
e. 

d image after a Zoom scan

wnload.

A tour of the scanning 

software
Book Contents Index

➮

➮

Preview area

The preview area in the scanning software 
window displays the:
■ preview image of the entire scanner glass, or
■ zoomed image of the selection area

When you Preview scan, the entire scanner glass 
area displays in the scanning software window.

Enlarging th

The size of th
the image dis

Enlarge the sc
want to increa
zoomed imag

Preview
area

A selection area in Preview scan

Selection
area

Zoomed
selection

area

Enlarge
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Info bar

The info bar displays the following information:

➊ the width of the output image

➋ the height of the output image

➌ scale of the output image

➍ the Output Type currently selected

➎ the Help button for HP PrecisionScan Pro

➊ ➋

Scanning so

➌
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Status bar

The status bar displays the following information:

➊ a message about the action you can take when 
the pointer is over some part of the scanning 
software window or a tool

➋ the number of KB (kilobytes), MB (megabytes), 
GB (gigabytes), or TB (terabytes) in the image 
displayed in the selection area (Image Size)
-or-
a progress bar for showing when the scanner is 
scanning or the scanning software is 
processing a command

The Image Size shown in the status bar is 
the number of KB, MB, GB, or TB in the 
image displayed in the selection area. 
This size is only an estimate of the actual 
size of the saved file. The file size depends 
on the format used to save the file (see 
page 100) and may be larger or smaller than 
the Image Size value shown.

T I P

➊

Scanning so
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Context-sensitive pointers

The shape of the pointer indicates the type of 
activity you can perform in the scanning software.

Selection area pointers

New selection area Draw a new selection area.

Move selection area ■ Move the selection area to a new lo
area.

■ Drag the selection area to another p
document.

■ When Ctrl key is pressed, drag the s
Windows desktop or to a folder in t

Resize selection area 
horizontally

Drag the mouse from a handle on a si
to resize the width of the selection are

Resize selection area 
vertically

Drag the mouse from a handle on the
selection area to resize the height of t

Resize selection area 
diagonally

Drag the mouse from a handle on a c
area to resize both the height and the
area.

Drop allowed
The program or folder the image has 
accepts this kind of drop.

Drop not allowed The program the image has been dra
accept this kind of drop.
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and.

o increase or decrease 

f the image to see the 
d in the pixel 
 Adjustment tool. Click 

f the image to see the 
d the pixel distribution 
tool. Click to set the 

tem for pop-up Help on 
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Ready pointer

Ready for activity ■ Click a menu item to select a comm
■ Click a list button to select a choice.
■ Click a button to turn it on or off, or t

a number.

Typing pointer

Data entry accepted Click, then type a value.

Pixel value pointers

White eyedropper Position this pointer over a light area o
area’s pixel value in the RGB meter an
distribution histogram in the Exposure

to set the Highlights value.
Black eyedropper Position this pointer over a dark area o

area’s pixel value in the RGB meter an
histogram in the Exposure Adjustment 
Shadows value.

What’s This Help pointer

What’s This Help Click on a tool, field, button, or menu i
that item.
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el tool
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l
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Image adjustment tools

Six tools can be used to make adjustments to the 
image in the selection area:
■ Output Resolution tool (see page 27)
■ Sharpen Level tool (see page 29)
■ Dimensions tool (see page 30)
■ Exposure Adjustment tool (see page 32)
■ Color Adjustment tool (see page 33)
■ Black & White Threshold tool (see page 34)

Each tool has controls you can set for applying to 
a final scan. Five of the tools have reset buttons 
for applying optimal values to their controls.

Displaying a tool

■ From the Tools menu, select the name of the tool 
you want to display. A checkmark displays next 
to the choice in the Tools menu and the tool 
appears.

Closing a tool

■ Click the Close button  in the tool’s title bar, or
from the Tools menu, select the name of the tool 
you want to hide. The checkmark disappears and 
the tool closes. The tool’s values are still applied 
to the image.

Docking a t

Two tools can
window:
■ Output Reso

■ Sharpen Lev

If either of the
the scanning 
next time you

To dock a too

■ Double-click
dockable to

To undock a 

■ Double-click
docked tool

You can pla
Windows d
1 Position t

bar.
2 Click and

T I P

Download from Www.Somanuals.com. All Manuals Search And Do



�

2 HP PrecisionScan Pro User’s Guide 27

olution
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e scanning software automatically 
timal output resolution to the image. 
ride the automatic setting by 
ferent value from the list box in the 

tion tool or by typing any value 
nd 999,999 in the field of the Output 

l.

 displayed on a monitor

5 as the resolution setting if the 
 viewed on a monitor, such as in 
Web page.

 commonly-used resolution 
he Output Resolution tool’s list 
esolution tab of the 
Scan Pro Preferences dialog box 
6).
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➮

➮

Output Resolution tool

The Output Resolution tool lets you determine the 
amount of data for the final scan of an image of a 
picture. See Set output resolution on page 83 for 
more about when to use the Output Resolution tool. 

After you have drawn a selection area, use this 
tool to:

➊ change the resolution 
setting, if necessary

➋ reset the resolution setting 
to the optimal value for the 
current output type

AutoResolution

When you choose an Output Type, the scanning 
software automatically applies the optimal output 
resolution to the selection area. For example, 
output resolution is automatically set to 150 when 
the True Color output type is selected, and set to 
300 for the Black & White Bitmap (raster) output 
type.

To re-apply AutoResolution, click  in the Output 

Resolution tool.

Custom res

When you cho
Type menu, th
applies the op
You may over
selecting a dif
Output Resolu

between 12 a
Resolution too

Images to be

Always use 7
image will be
email or on a 

➊ ➋

You can add
settings to t
box in the R
HP Precision

(see page 4

T I P
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➮

➮

Images to be printed

The resolution setting for printing images varies, 
depending on the output type applied to the 
image and the maximum resolution capability of 
the printer (see page 83).

To print images of photographs with the True 

Color, 256 Color, or Grayscale output types, set the 
value in the Output Resolution tool according to the 
following table.

To print images of drawings with the 256 Color or 
Black & White Bitmap (raster) output types, set the 
value in the Output Resolution tool equal to the 
resolution of the printer.

300 dpi 
printer

600 dpi 
printer

1200 dpi 
printer

Resolution 
tool setting

100 150 300

You can change the resolution settings 
available in the Resolution tool’s list box 
(see page 46).

T I P
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999,999 in

■ If you cha
in the Out
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you can a
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➮

➮

Sharpen Level tool

The Sharpen Level tool lets you enhance details in 
the image of a picture for the final scan. See 
Sharpen on page 68 for more about how to use the 
Sharpen Level tool.

When you choose an Output Type for the image of 
a picture, the scanning software automatically 
applies the optimal sharpen level. 

After you have drawn a selection area, use this 
tool to:

➊ select a sharpen level 
from the list box, if 
necessary

➋ reset the sharpen level 
setting to the optimal 
value for the current 
output type

The choices in the Sharpen Level list box are listed 
in order from the least amount of sharpening to 
the most amount of sharpening:
■ None
■ Low
■ Medium
■ High
■ Extreme

➊ ➋

After you se
Sharpen Lev

sharpen lev
area.

T I P
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➮

➮

Dimensions tool

The Dimensions tool lets you change the size of the 
scanned image of a picture so that the image will 
be the size you want it when you use the image in 
another program or print it. For example, you can 
save a small scanned image from a larger original 
picture.

In the Dimensi

■ set the dim
■ set the unit

output dime
■ scale the im

original
■ set the outp

final scan

Original picture

Sc
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tput dimensions on page 58 for more 
 use the Dimensions tool.

➎

➍

wnload.

A tour of the scanning 

software
Book Contents Index

➮

➮

After you have drawn a selection area, use the 
Dimensions tool to:

See Set the ou

about how to

➊ adjust the dimensions of the selection area

➋ set values for the width and height of the image 
to be included in the final scan

➌ select the units you want to work with

➍ enlarge or reduce output dimensions of the 
image for the final scan proportionally by scaling 
to a percentage of the original’s size

➎ lock the output dimensions so you can change 
the dimensions of the selection area without 
changing the output dimensions

➊

➋

➌

To preserve image quality when you 
use it in another program:
■ measure the dimensions of the area 

in which you will place the image, 
then

■ use the Dimensions tool in 
HP PrecisionScan Pro to scale or resize 
the image to fit that area.

T I P
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➮

➮

Exposure Adjustment tool

The Exposure Adjustment tool lets you make fine 
adjustments to highlights, shadows, and 
midtones, or set the output level of black and 
white pixels in a color or grayscale image of a 
picture. See Adjust exposure on page 70 for more 
about how to use the Exposure Adjustment tool.

After you ch
Exposure Ad

changes can

T I P

After you have drawn a selection area, use 
this tool to:

➊ adjust highlights in the image

➋ adjust shadows in the image

➌ adjust midtones in the image

➍ adjust output level of white pixels

➎ adjust output level of black pixels

➏ view black pixels that will be clipped in the 
final scan

➐ view white pixels that will be clipped in the 
final scan

➑ view RGB values and pixel distribution for 
any light or dark area of the image

➒ reset all the exposure controls to the values 
determined by the scanning software

➊
➋

➌

➍
➎

➒
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➮

➮

Color Adjustment tool

The Color Adjustment tool lets you change the hue 
and make colors brighter in a color image. 

See Adjust color on page 80 for more about how to 
use the Color Adjustment tool.

After you hav
tool to:

➊ change the
in the Color

➋ change the
the Color W

➌ set color sa
higher the 
colors

➍ change the
Color Whee

➎ reset the co
determined

➊

➌

➎

➋
➍

After you ch
Adjustment 

settings can
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➮

➮

Black & White Threshold tool

The Black & White Threshold tool lets you change 
the dividing point for black and white pixels in an 
image that uses the Black & White Bitmap (raster) 

output type. All pixels below the threshold will be 
output as black and all pixels above the threshold 
will be output as white. 

After you have drawn a selection area, use this 
tool to:

➊ view the distribution of black and white pixels 
in the selection area

➋ set the black and white threshold (see page 85)

➌ set the color channel

➍ set the black and white threshold to the value 
determined by the scanning software

➋

➍➊

➌

After you ch
White Thres

settings can

T I P

Black & Whit

Default
threshold
setting

Low
threshold
setting
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, the Windows Start button.
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Scan Pro Help or Contents and Index, 

 in the info bar.
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➮

➮

Online Help

Quick Help in the scanning software 
window

A short description, or ToolTip, displays when you 
move the pointer over of each part of the scanning 
software window or a tool, and a longer 
description displays in the status bar.

What’s This Help in the scanning software 
window

Use What’s This Help to learn about any object in 
the scanning software window.

To use What’s This Help for the scanning 
software window

1 Click  in the toolbar, or the  in the title bar 

of a tool, to change the pointer to .

2 Click an item in the scanning software window 
or in a tool. 

A popup Help description appears. 

You can also press Shift+F1 to display the What’s 

This pointer for the scanning software window.

To use What

1 Click  in t
pointer to 

2 Click an item
A popup He

HP Precisio

Use HP Precisi

the scanning 

To start Help

1 Select 
2 From the St

choose HP S

Help:HP Sca

The HP Prec

To start Help
window

■ From the sc
HP Precision

or click 

The HP Prec
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➮

HP ScanJet Coach

Use the HP ScanJet Coach to learn the steps for 
scanning.

To start the HP ScanJet Coach from the 
Desktop

1 Select , the Windows Start button.
2 From the Start menu, choose Programs, then 

choose HP ScanJet Software:HP Online 

Help:HP ScanJet Coach.

The HP PrecisionScan Pro Help window appears.

The HP ScanJet Coach appears.

To start the HP ScanJet Coach from the 
scanning software

■ Click  in the scanning software toolbar, or 
from the scanning software Help menu, select 
HP ScanJet Coach.

The HP ScanJet Coach appears.

Videos

Several video
accessed from
1 Insert the H

CD-ROM dr
2 Turn on the

To start a vid

1 Select 
2 From the St

choose HP S

Me Videos.

To start a vid

1 Start the sc
2 From the H

To start a vid

When you see
topic,

■ Click 
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➮

➮

Online manuals

In addition to this HP PrecisionScan Pro User’s 
Guide online manual, you can view the 
HP ScanJet Automatic Document Feeder Guide in 
Adobe Acrobat Reader, which describes how to use 
the HP ScanJet Automatic Document Feeder.

To view an online manual from the Desktop

1 Select , the Windows Start button.
2 From the Start menu, choose Programs, then 

choose HP PrecisionScan Pro:HP Online Help and 
the manual.

Adobe Acrobat Reader starts and displays the 
online manual.

To view an online manual from the scanning 
software

■ From the scanning software Help menu, select 
the manual.

Adobe Acrobat Reader starts and displays the 
online manual.
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➮

➮

Save and re-use adjustment settin

You can save the settings you have made to an 
image and apply those settings to a another scan 
during the current scanning session or after 
restarting HP PrecisionScan Pro. When you save a 
set of settings, you give the set of settings a name. 

When you want to use those settings for a 
different image, load the settings using the same 
name (page 40). 

The settings saved are:
■ Output Type

■ Dimensions tool values (output size and output 
scale)

■ Output Resolution tool value
■ Sharpen Level tool value
■ Exposure Adjustment tool values
■ Color Adjustment tool values
■ Black & White Threshold tool value
■ the selection area, if one existed

 

Save Setting
Output Se
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Saving a se

1 From the Sc

The Save Se

page 38).
2 Review the

and the Too

3 If the settin
the text fiel
then type a

4 Click Save.
• The Save 

• The name
use (see p

Save Settings dialog box
Tools Settings tab
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➮

➮

Loading a set of settings

Any set of scanning settings you have saved with 
the Save Settings dialog box can be applied to the 
image currently displayed in the preview area. 

1 From the Sc

The Load Se

2 From the lis
settings you

3 Review the
and the Too

4 If the settin
Load.
• The Load 

• The settin

Deleting a s

1 From the Sc

The Save Se

2 From the lis
settings you

3 Click Delete

The Delete set

4 Click Yes. 

The set of s
saved settin

Load Settings dialog box
Output Settings tab

The settings name is selected
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➮

➮

Set preferences

Preferences for the scanner and the scanning 
software can be set in the HP PrecisionScan Pro 

Preferences dialog box.

The HP PrecisionScan Pro Preferences dialog box has 
several tabs. These tabs are:

➊ Scanner (see page 42)

➋ Selection Area (see page 44)

➌ Resolution (see page 46)

➍ Controls (see page 47)

Opening th
Preferences

■ From the Sc

The HP Prec

appears.

To activate a checkbox choice in the 
HP PrecisionScan Pro Preferences dialog box: 
■ Click the checkbox to place a checkmark 

in it .
To activate an option button choice in the 
HP PrecisionScan Pro Preferences dialog box: 
■ Click the option button to place a dot

in it .

✔

●

T I P

➊ ➋
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➮

➮

Scanner tab

The Scanner tab of the HP PrecisionScan Pro 
Preferences dialog box has checkboxes for 
enabling:

➊ a Preview scan when the scanner’s Scan 
button is pushed (page 43)

➋best quality scaling (page 43)

➌best quality sharpening (page 43)

➍maximum pixel depth (page 43)

To change settings:

1 Select the checkboxes you want to turn on or 
off.

2 Click Apply.
3 Click another tab, or click OK to close the 

HP PrecisionScan Pro Preferences dialog box.

➊

➋
➌
➍

All the checkbox
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ing processed. If your scanner is 
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➮

➮

Preview scan when scanner button is pushed

When this checkbox is checked, each time you 
push the Scan button on the scanner the scanner 
automatically performs a Preview scan. This 
means you can start a Preview scan with the Scan 
button.

When this checkbox is not checked, pushing the 
Scan button on the scanner does not start a 
Preview scan. You will need to start a Preview scan 
by: 
■ clicking  in the toolbar

-or-
■ choosing Preview from the Scan menu

Best Quality Scaling

When this checkbox is checked, the highest quality 
scaling is applied to the final scan.

When this checkbox is not checked, scanning is 
faster because normal quality scaling is applied to 
the final scan.

Best Quality Sharpening

When this checkbox is checked, the highest quality 
of sharpening is applied to the final scan.

When this checkbox is not checked, scanning is 
faster because normal quality sharpening is 
applied to the final scan.

Maximum P

When this che
bit depth is ap
highest qualit

When this che
faster for mos
image data be
connected to 
significant im
large degrada
remove the ch

By default, 
installed, al
the Scanner

Preferences 
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➮

➮

Selection Area tab

The Selection Area tab of the HP PrecisionScan Pro 
Preferences dialog box has checkboxes for 
controlling whether the scanning software should 
automatically:

➊ create a selection area when the mouse is 
clicked (page 45)

➋determine the best Output Type for the 
selection area (page 45)

➌determine the optimal exposure level for the 
selection area (page 45)

➍determine the optimal color balance and 
saturation for the selection area (page 45)

To change settings:

1 Select the checkboxes you want to turn on or 
off.

2 Click Apply.

3 Click another tab, or click OK to close the 
HP PrecisionScan Pro Preferences dialog box.

➊
➋
➌
➍

By default, whe
all the checkbox
tab of the HP Pr

box.

T I P
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➮

➮

Automatically create selection area after a 
mouse click

When this checkbox is checked, the scanning 
software automatically creates a selection area 
when you click over a part of the image while the 
pointer looks like this: .

When this checkbox is not checked:
■ the scanning software does not automatically 

create a selection area when you click over a 
part of the image

■ you will need to draw the selection area (see 
page 53)

Automatically set the output type after 
selection

When this checkbox is checked, the scanning 
software automatically changes the output type 
for a new selection area created by clicking (see 
page 52). The scanning software determines which 
output type to apply based on the contents of the 
selection area:
■ True Color is applied when the selection area 

contains enough color
■ Grayscale is applied when the selection area 

contains mostly grayscale information
■ Black and White Bitmap (raster) is applied if the 

selection area contains mostly black and white 
information

When this che
software does
when a new s
need to manu
type from the
a new selectio

Automatical

When this che
create a new 
page 52), the 
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➮

➮

Resolution tab

To add a resolution default:

1 Click Add. 
2 In the Default Resolution dialog box, type a 

number between 12 and 999,999.
3 Click OK.
4 Click another tab, or click OK to close the 

HP PrecisionScan Pro Preferences dialog box.

To delete a r

1 In the Resol

want to del
2 Click Delete

3 Click anoth
HP Precision

The Resolution tab of the HP PrecisionScan Pro 
Preferences dialog box controls the resolution 
values contained in the Output Resolution tool’s 
list box. It has:

➊ a list of the resolution values currently 
available in the Output Resolution tool’s list box

➋ an Add button for adding a resolution to the 
Output Resolution tool’s list box

➌ a Delete button for deleting a resolution from 
the Output Resolution tool’s list box

➍ the two resolutions that always remain in the 
Output Resolution tool’s list box

➊

➌

➋
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➮

➮

Controls tab

The Controls tab of the HP PrecisionScan Pro 
Preferences dialog box has option buttons for 
selecting which control range readout to use for 
scanning.

The control ra
resolution per
Exposure Adju

tools. Using a
range results 
for exposure 

➊ 8-bit readout (0-255) — sets the scanner to use 
8 bits of tonal resolution per color

➋ 10-bit readout (0-1023) — sets the scanner to 
use 10 bits of tonal resolution per color

➌ 12-bit readout (0-4095) — sets the scanner to 
use 12 bits of tonal resolution per color

To change settings:

1 Click the option button to select it.
2 Click Apply.
3 Click another tab, or click OK to close the 

HP PrecisionScan Pro Preferences dialog box.

➊
➋
➌
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➮

➮

Basic steps for scanning pictures

Quick scan

1 Preview scan (page 50).
2 Create a selection area of the part of the image 

you want in the final scan (page 51).
3 Save, copy, drag-and-drop, or print (see Chapter 

6 Saving scanned images page 94).

Optional adjustments

(See Chapter 4 Adjusting images of pictures page 65.)
■ Zoom scan to see the image at closer range 

(page 56).
■ Set the output dimensions if you want to save 

the image as a different size (page 58).
■ Choose an Output Type if you need to save the 

image with different colors. For example, you 
could save a color image as a grayscale or a 256 
color image (page 62).

To adjust an i
the True Color

Color output t
■ Sharpen (pa
■ Adjust expo

(page 70)
■ Adjust colo

To adjust an i
the Grayscale 
type:
■ Sharpen (pa
■ Adjust expo

(page 70)

To adjust an i
a Black & Whit

■ Sharpen (pa
■ Adjust black

threshold (p
color chann

Be sure to keep the original in the same 
place on the scanner glass until the final 
scan of the image is completed.

T I P
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an displayed in the preview area
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➮

➮

Preview scan

A Preview scan displays a low-resolution image of 
everything on the scanner glass so you can create 
a selection area to work with (see page 51). A final 
scan will be performed when the image is saved, 
copied, printed, or dragged to another program.

Using the Scan button to Preview scan

If the ScanJet Button Manager is set to 
communicate with HP PrecisionScan Pro:
■ Push the Scan button on the scanner once.

The scanner performs a Preview scan and the 
preview image appears in the preview area.

For information on configuring the HP ScanJet 

Button Manager, see page 12.

Using the scanning software to Preview 
scan

You can Preview scan from the scanning software:

■ Click , the Preview button in the toolbar, or
■ from the Scan menu, select Preview, or
■ press Ctrl+R.

The scanner performs a Preview scan and the 
preview image appears in the preview area.

A Preview sc

Preview
area
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➮

➮

Create a selection area 

You must create a selection area to indicate the 
part of the image you want to save to a file, copy, 
print, or drag-and-drop. 

The area you select will be enclosed by a selection 
border, which you can resize later (see page 55).

There are several ways to create a selection area:
■ click (see page 52)
■ draw (see page 53)
■ select everything on the scanner glass (see 

page 54)

The selection area determines the part of the 
image that is included in the final scan when 
you save, copy, print, or drag-and-drop.

If no selection area exists: 
■ you cannot perform drag-and-drop
■ the entire area of the scanner glass will be 

included when you save, copy, or print

T I P
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lection border around the 

wnload.
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➮

➮

Clicking to create a selection area

1 Position the  pointer near the upper-left 
corner of the area you want to work with.

2 Click.

A rectangular selection area is created and the 
parts of the preview image outside the selection 
area are faded to indicate they will not be 
included in the final scan.

To enable clicking to create a selection area 
enable the Selection Area preference option 
Automatically create selection area after a 
mouse click (see page 45).

T I P
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area
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he selection area

e the selection area so you can 
ent one.
it menu, select Clear Selection, or

 border surrounds the selection 

ppear on the corners and in the 
 each side of the selection 

e inside the selection border 
ivid.
e outside the selection border 
aded.
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➮

➮

Drawing to create a selection area

1 Position the  pointer over one corner of the 
area you want to select.

2 Press the mouse button and drag the pointer 
diagonally to create a selection border.

3 Release the mouse button.

Removing t

You can delet
create a differ
■ From the Ed

■ press Esc.

Selection
area

Handles

Selection border

■ A dashed
area.

■ Handles a
middle of
border.

■ The imag
remains v

■ The imag
appears f

T I P
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lection border around the entire 
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➮

➮

Selecting the entire preview area

After a Preview scan, use the Select All command to 
create a selection area containing the entire 
preview area.
■ From the Edit menu, select Select All

– or –
■ press Ctrl+A.

A selection border is drawn around the entire 
preview area.

Selecting the entire zoomed area

After a Zoom scan, use the Select All command to 
create a selection area containing the entire 
zoomed area.
■ From the Edit menu, select Select All

– or –
■ press Ctrl+A.

A selection border is drawn around the entire 
zoomed area.

A se

Preview
area
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ensions tool

he fields in the Selection Area 

ea of the Dimensions tool to define 
 of the selection area. (See page 30 
t the Dimensions tool.)
ols menu, select Dimensions.

ions tool appears.
t button in the Units field and select 
u want to work with.
idth of the selection area, type the 
 in the Width field of the Selection 

ions area.
 same aspect ratio for the selection 
the Selection Area Dimensions area 
e proportional to the new width 
s Enter, 

 existing Selection Area Dimensions 
 value, click in any other field of the 
tool.
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➮

➮

Moving the selection area

You can move the selection area to a different 
location in the preview area.
1 Position the pointer inside the selection area.

The pointer changes to .
2 Drag the selection area to its new location.

Adjusting the size of selection area

You can change the size of the selection area two 
ways:
■ click and drag one of the handles on the 

selection border (see the picture on page 53)
■ set dimensions for the selection area in the 

Dimensions tool

Use the handles on the border

1 Position the pointer over the handle on the 
corner or side of the selection border you need 
to adjust.

The pointer changes to a bidirectional arrow 
(see page 24).

2 Click on the handle and drag the side of the 
border to a new location.

3 Release the mouse button.

Use the Dim

You can use t
Dimensions ar
the exact size
for more abou
1 From the To

The Dimens

2 Click the lis
the units yo

3 To set the w
width value
Area Dimens

4 To keep the
area (keep 
height valu
value), pres

-or-

to leave the
area height
Dimensions 

Download from Www.Somanuals.com. All Manuals Search And Do



�

3 HP PrecisionScan Pro User’s Guide 56

 selection
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➮

➮

Zoom scan

Zoom scan lets you view the selection area at 
closer range. Use the Zoom command to see the 
image better when you adjust it.

Performing a Zoom scan

1 Create a selection area (page 51).
2 To enlarge the view of the selection area:

• Click , the Zoom button in the toolbar

– or –
• from the Scan menu, choose Zoom.

The scanner scans the selection area and the 
selection area fills the preview area.

Zoomed
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o Zoom)

ew menu, choose Undo Zoom.

 image appears with all settings 

ferent area of the preview image.

e Zoom button in the toolbar, 

an menu, choose Zoom.

r scans the selection area.

 the new selection area appears 

w image

Zoom

Second zoomed image

➌
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➮

➮

Return to the preview image (Und

After you have used the Zoom command to 
enlarge the view of the selection area, you can use 
the Undo Zoom command to view the preview 
image without performing another Preview scan. 
This can be useful when you have several pictures 
on the scanner glass and you want to use each 
one individually.

Using Undo Zoom

Use the Undo Zoom command when you want to 
create a different selection area in the preview 
image.
1 Click , the Undo Zoom button in the toolbar, 

– or –

from the Vi

The preview
preserved.

2 Select a dif

3 Click , th
– or –
from the Sc

The scanne

The view of
enlarged.

Preview image

Zoom

First zoomed image Preview image Previe

Undo Zoom Click

➊ ➋
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rder:
 units of measurement you want to 
page 59).
lection area (page 51) and adjust the 
election area (page 55).
utput dimensions (page 60).

or more about the Dimensions tool.

400% Scaled image
t,
e,
y, or
g-and-
p
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➮

➮

Set the output dimensions

To get the best quality image, determine in 
advance the physical dimensions you want for the 
image and set those dimensions with the 
Dimensions tool in the scanning software. For 
example, if the original is smaller than the size you 
need the image to be in another program, resize it 
now. Resizing an image in the destination 
program can cause the image to become fuzzy or 
jagged.

The usual pro
follows this o
1 Choose the

work with (
2 Create a se

size of the s
3 Adjust the o

See page 30 f

Original picture Create a selection
area

Set output
dimensions
by scaling

Prin
sav
cop
dra
dro

➊ ➌
Set units

➋

Scale
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lection area (page 51).
t button in the Units field of the 
tool and select a unit of 
nt.

hange units:
t width value in both Width 
nges
t height value in both Height 
nges
t width value in the info bar 

t height value in the info bar 
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➮

➮

Setting units

The Units field in the Dimensions tool sets the units 
of measurement for the Width and Height fields in 
the Selection Area Dimensions and the Output 

Dimensions areas. The units available are:
■ inches
■ centimeters
■ points
■ pixels

To set units

1 Create a se
2 Click the lis

Dimensions 
measureme

When you c
■ the outpu

fields cha
■ the outpu

fields cha
■ the outpu

changes
■ the outpu

changes

T I P
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hange the Scale value, you will 
image change in the preview 

t when Scale is set to 100%

t when Scale is set to 50%
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➮

➮

Scaling output as a percentage of the 
original

The Scale field is useful for setting output 
dimensions when you know approximately how 
big you want the final image to be.

For example, when you want the image to be half 
the size of the original, set the value in the Scale 
value to 50%. Or if you want the final image to be 
twice the size of the original, set the Scale value to 
200%.
1 Create a selection area (page 51).
2 Click the list button in the Scale field and select a 

percentage

-or-

type a value in the Scale field, then press Enter.

The new output width appears in the Width field 
in the Output Dimensions area and in the info bar. 

The new output height appears in the Height 
field in the Output Dimensions area and in the 
info bar. 

The new scale percentage appears in the Scale 
field and in the info bar.

The new image size displays in the Image Size 
box in the status bar.

The selection area remains the same.

When you c
not see the 
area.

T I P
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Image outpu
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ues for output dimension

he output dimensions you have 
u can change the size of the selection 
hanging the output dimensions.

lection area (page 51).
es for width and height in the Output 

area of the Dimensions tool.

ize of the selection area (see 

n area will be resized proportionally.

dimensions remain the same.
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➮

➮

Typing values for output width and height

You can type the output dimensions when you 
know exactly how big you want the final image to 
be.
1 Create a selection area (page 51).
2 Click in the Width field of the Output Dimensions 

area of the Dimensions tool and type the value 
for the width

3 Press Tab or Enter, 

– or –

click in the Height field of the Output Dimensions 
area and type the value for the height, then 
press Tab or Enter.
• The new output width appears in the Width 

field of the Output Dimensions area and in the 
info bar. 

• The new output height appears in the Height 
field of the Output Dimensions area and in the 
info bar. 

• The new scale percentage appears in the Scale 
field and in the info bar.

• The new image size displays in the Image Size 
box in the status bar.

• The selection area remains the same.

Locking val

You can lock t
defined so yo
area without c
1 Create a se
2 Set the valu

Dimensions 

3 Click .
4 Adjust the s

page 55).

The selectio

The output 
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output type selected by the scanning 
 not be the most appropriate for the 
se the image. For example, when 

rint the image of a color photograph 
 white printer, you may want to set 
e to Grayscale.
types are more suitable for images 
splayed on a monitor, others are 
 for printing.

age 64 lists results you can get with 
pe for various types of originals.
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➮

➮

Choose an output type

The output type selected in the Output Type menu 
determines the bit depth and color palette applied 
to the final scan of pictures and drawings, but not 
for images that will be converted to text. The table 
on page 64 lists bit depths and color palettes for 
each output type that is appropriate for images of 
pictures and drawings. 

The scanning software automatically selects an 
appropriate output type based on the contents of 
the selection area. The current output type setting 
displays in the info bar of the scanning software 
window.

However, the 
software may
way you will u
you want to p
on a black and
the output typ
Some output 
that will be di
more suitable

The table on p
each output ty

True Color 24-bit, millions of colors

Grayscale 8-bit, 256 shades of gray

Black & White
Bitmap (raster), 
Scalable (vector)

1-bit black and white

256 Color
Web Palette
System Palette

Optimized Palette

8-bit, 256 colors

O u t p u t  t y p e s  f o r  p i c t u r e s
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ults with images that will be 
-color display monitors, do not 

 Color Optimized Palette output 

timized palette is used in an 

te is unique to that image and 
e palette colors are applied to 
w that is displaying the image

other windows that are 
 at the same time will be 
, because those other windows 
dard, system palette
w displaying the image with the 
 palette will be temporarily 

 with fewer colors when focus 
o a different window
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➮

➮

Changing the output type

1 Create a selection area (page 51).
2 From the Output Type menu, choose an output 

type for the image of the picture you scanned.

Make your output type choice based on:
• whether the image will be displayed on a 

monitor or printed in hardcopy
• how many colors you want in the final scan
• file size

After you select an output type from the Output 

Type menu:
• you will see the image change in the preview 

area
• the new output type displays in the info bar
• the new image size displays in the status bar
• a new sharpening level may appear in the 

Sharpen Level tool
• a new value may appear in the Output 

Resolution tool

For best res
used on 256
use the 256

type. 
When an op
image:
■ that palet

the uniqu
the windo

■ colors in 
displayed
corrupted
use a stan

■ the windo
optimized
rendered
changes t
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f original

Black and white 
photograph

Black and white 
drawing

one-color tint image for printing

isplaying on a monitor

 printing or displaying on a monitor; 
other program

age for resizing in another program

one-color tint image for displaying 
on a Web page

one-color tint image for displaying 
a presentation on a monitor
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➮
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Suggestions for choosing output type

Type o

Output Type
Color 
photograph

Color 
drawing

True Color

millions of colors (24-bit color) best color image for printing

Grayscale

8-bit (256 shades of gray) grayscale image for printing or d

Black & White

1-bit black 
and white 
(only black 
and white)

Bitmap (raster) black and white raster image for
not appropriate for resizing in an

Scalable (vector) scalable black and white vector im

256 Color 

8-bit color 
(256 shades 
of color)

Web Palette best color for displaying images 
on a Web page

System Palette best color for displaying 
wallpaper, multiple images, or a 
presentation on a monitor

Optimized Palette best for selecting the colors 
closest to those in the image
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66 Tools for making

68 Sharpen

70 Adjust exposure

80 Adjust color

83 Set output resol
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87 Set color channe
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t type affects which image 
s you can make

ilable for making adjustments to an 
ture depend on the Output Type you 
.

 for color output types

h the True 

Color 
n be 

wnload.
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➮

➮

Tools for making adjustments

The tools in the scanning software can be used to 
adjust the image of a picture before you save, 
copy, drag-and-drop, or print the image. 

After you have selected an output type (page 62) 
and cropped the image by creating a selection 
area (page 51), the adjustments you can make and 
the tools to use are:

How outpu
adjustment

The tools ava
image of a pic
have selected

Adjustments

An image wit
Color or a 256 

output type ca
adjusted for:
■ sharpening
■ exposure
■ color
■ resolution

Adjustment Tool

■ sharpening Sharpen Level, page 68

■ exposure Exposure Adjustment, page 70

■ color Color Adjustment, page 80

■ resolution Output Resolution, page 83

■ black and white
threshold

Black & White Threshold, 
page 85

To get the best scanned image, use the 
tools in the scanning software to make 
adjustments instead of making adjustments 
in another program.

T I P
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 for Black & White Bitmap 
ut type

 the Black & 

raster) 

n be 

hite 

 for Black & White Scalable 
ut type

 the Black & 

 (vector) 

nnot be 
 any of the 
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➮

➮

Adjustments for Grayscale output type

An image with the 
Grayscale output type 
can be adjusted for:
■ sharpening
■ exposure
■ resolution

Adjustments
(raster) outp

An image with
White Bitmap (

output type ca
adjusted for:
■ sharpening
■ resolution
■ black and w

threshold

Adjustments
(vector) outp

An image with
White Scalable

output type ca
adjusted with
tools.
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g software automatically 
optimal sharpen level for the 
 applied to the image.

True Color output type

en level High sharpen level

wnload.
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➮

➮

Sharpen

The right amount of sharpening enhances detail in 
the scanned image. Too much or too little 
sharpening can accent flaws and emphasize 
undesirable patterns in images of photographs, 
drawings, or line art.

If the original picture is not sharp, or you want to 
create a special effect, you can increase or 
decrease sharpening with the Sharpen Level tool. 
The sharpen level you select will be applied to the 
final scan.

See page 29 for more about the Sharpen Level tool.

Grayscale output type

Medium sharpen level Extreme sharpen level

The scannin
selects the 
output type

T I P

Medium sharp

Download from Www.Somanuals.com. All Manuals Search And Do



�

4 HP PrecisionScan Pro User’s Guide 69

e default sharpen level

e AutoSharpen button in the Sharpen 

al sharpen level determined by the 
 software is applied to the Sharpen 

.
t of the change to the sharpen level 
en in the preview area.

 change the sharpen level for 
 of a picture, you will see the 

ange in the preview area.
nge the sharpen level
rpen Level tool and 
ge the output type, 
pply AutoSharpen 
w output type by clicking .

wnload.
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➮

➮

Changing the sharpen level

1 From the Tools menu, select Sharpen Level.

The Sharpen Level tool appears (see page 29).
2 Click the list box button, drag to the sharpen 

level you want, then release the mouse button,

– or –

Click in the sharpen level text field and type the 
first letter of a sharpen level.
• The new sharpen level is applied.
• The result of the change to the sharpen level 

can be seen in the preview area.
• The AutoSharpen button in the Sharpen Level 

tool becomes active.
Applying th

■ Click , th
Level tool.
• The optim

scanning
Level tool

• The resul
can be se

Black & White Bitmap (raster) output type

None sharpen level Extreme sharpen level

■ When you
the image
image ch

■ If you cha
in the Sha

then chan
you can a
for the ne
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xposure Adjustment tool

ols menu, select Exposure 

e Adjustment tool appears. (See 

 following sections for using the 
justment tool:
hlights on page 71

adows on page 72

dtones (brightness) on page 73

 clipping of pixels on page 76

 output levels on page 78

e default exposure settings

to button in the Exposure Adjustment 

al exposure settings determined by 
ing software are applied to the 

Adjustment tool.
ts of the changes to the exposure 
an be seen in the preview area.

wnload.

Adjusting images of 

pictures
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➮

➮

Adjust exposure

The scanning software automatically selects the 
optimal exposure settings for the output type 
applied to the image of a picture. However, if the 
original picture needs the brightness or contrast 
adjusted, you can use the Exposure Adjustment tool 
to increase or decrease:
■ highlights (see page 71)
■ shadows (see page 72)
■ midtones (gamma) (see page 73)
■ clipping of white and black pixels (see page 76)
■ output levels for white and black pixels (see 

page 78)

The exposure settings you select will be applied to 
the final scan.

You can also use the Exposure Adjustment tool to:
■ view the distribution of pixels (see page 74)
■ read the RGB values of the pixels in the image 

(see page 74).

The Exposure Adjustment tool is active for the color 
and grayscale output types.

Using the E

1 From the To

Adjustment.

The Exposur

page 32.)
2 Refer to the

Exposure Ad

■ Changing hig

■ Changing sh

■ Changing mi

■ Checking for

■ Setting pixel

Applying th

■ Click the Au

tool.
• The optim

the scann
Exposure 

• The resul
settings c
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 details in light areas

etails in the light areas of the image, 
number in the Highlights field:
 left side of the slider,

r number in the Highlights field, then 
r Enter,

WN spin button next to the Highlights 

Highlights set at 122t at 215

wnload.

Adjusting images of 

pictures
Book Contents Index

➮

➮

Changing highlights

The Highlights control in the Exposure Adjustment 
tool lets you select the lightest printable value in 
the image. This gives coverage to areas that 
would otherwise remain the color of the paper. 
You may change highlights to:
■ lighter to bring out details
■ darker to minimize details

The range for the number in the Highlights field is 
set in the Preference Controls tab (see page 47).

Bringing out

To bring out d
decrease the 
■ Click on the

– or –
■ type a lowe

press Tab o
– or –

■ click the DO
field.

slider

field

DOWN spin button

UP spin button

Highlights

control

You can change the amount of tonal 
resolution per color available for correction 
in the Exposure Adjustment tool (see 
page 47).

T I P
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 details in dark areas

etails in the dark areas of the image, 
number in the Shadows field:
 left side of the slider,

r number in the Shadows field, then 
r Enter,

WN spin button next to the Shadows 

f the change to Shadows can be seen 
ew area.

Shadows set at 3at 10

wnload.
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➮

➮

Changing shadows

The Shadows control in the Exposure Adjustment 
tool lets you select the darkest printable value in 
the image. This allows you to bring out detail in 
areas that would otherwise become black. You 
may make dark parts of images:
■ lighter to bring out details
■ darker to minimize details

The range for the number in the Shadows field is 
set in the Preference Controls tab (see page 47).

Bringing out

To bring out d
decrease the 
■ Click on the

– or –
■ type a lowe

press Tab o
– or –

■ click the DO
field.

The result o
in the previ

Shadows

slider

field

DOWN spin button

UP spin button

control

A Shadows value close to or at zero 
generally produces an image with better 
shadow detail.

T I P
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the image

e image overall, increase the 
 Midtones field:
 right side of the slider,

er number in the Midtones field, then 
r Enter,

 spin button next to the Midtones 

f the change to Midtones can be seen 
ew area.

Midtones set at 3.0at 2.2

wnload.

Adjusting images of 

pictures
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➮

➮

Changing midtones (brightness)

The Midtones control in the Exposure Adjustment 
tool lets you brighten or darken an image overall 
by changing the gamma value.

The range for the number in the Midtones field is 
1.0 to 4.0.

Brightening 

To brighten th
number in the
■ Click on the

– or –
■ type a high

press Tab o
– or –

■ click the UP
field.

The result o
in the previ

Midtones

slider

field

DOWN spin button

UP spin button

control

If you will be sharing the image with others, 
the Midtones value 2.2 is recommended, 
since the brightness of monitors varies.

T I P

Midtones set 
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 the settings for Highlights and 
does not change the graph in 
ram.
 the selection area changes the 
he histogram.
nes setting is not represented in 
ram.
 in the histogram represents 

ribution in the input image, not 
ge that will be output.

nder the eyedropper pointer

wnload.

Adjusting images of 

pictures
Book Contents Index

➮

➮

Pixel distribution histogram

The histogram in the Exposure Adjustment tool is a 
graph of the distribution of pixels in the selection 
area. The vertical lines in the histogram show the 
current settings for Shadows and Highlights.

➊The magenta line in the histogram represents 
the current setting for Shadows, the darkest 
areas in the image.

➋The red line in the histogram represents the 
current setting for Highlights, the lightest areas 
in the image.

➌The turquoise line appears in the histogram 
when either eyedropper pointer is positioned 
over the image. It shows you where the pixels 
at that place in the image occur in the 
histogram.

Shadows Highlights

➊ ➋

■ Changing
Shadows 
the histog

■ Changing
graph in t

■ The Midto

the histog
■ The graph

pixel dist
in the ima

T I P

Pixels u
➌
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ointer over the image.
values and pixel color appear in the 
r.
oise line appears in the histogram.

me eyedropper button again.
eter dims.

er returns to normal.

 while the eyedropper pointer is 
age unless you want to change 
for Highlights or Shadows.

wnload.

Adjusting images of 

pictures
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➮

➮

RGB Meter

You can view the RGB values and pixel color for 
any spot in a color or grayscale image with the 
RGB Meter in the Exposure Adjustment tool.

Using the RGB Meter

1 Click either eyedropper button in the Exposure 

Adjustment tool:
■ When you click , the pointer changes to this: 

.
■ When you click , the pointer changes to this: 

.

2 Move the p
• The RGB 

RGB Mete

• The turqu

3 Click the sa
• The RGB M

• The point➊ ➋

➊ RGB values 

➋ Pixel color

Do not click
over the im
the setting 

T I P
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Appearance when
neither Exposure Alert

button is on

rance when
ite Exposure Alert

, is turned on

Appearance when
the black Exposure Alert

button, is turned on

wnload.

Adjusting images of 

pictures
Book Contents Index

➮

➮

Checking for clipping of pixels

The Exposure Alert buttons in the Exposure 

Adjustment tool warn you of areas of a color or 
grayscale image that contain no detail in the 
lightest and darkest areas of the image. The 
lightest area will print as the color of the paper, 
with no ink or toner, and therefore no detail. The 
darkest areas will print with the blackest color of 
ink or toner, saturating the area with the same 
color of black with no visible detail. 

The Exposure Alert buttons in the Exposure 

Adjustment tool are:

■  – for viewing white pixels that will be 
clipped in the final scan

■  – for viewing black pixels that will be clipped 
in the final scan

Appea
the wh
button
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 removing clipped dark areas

e black Exposure Alert button.

eas in the image that will print as 
ppear white in the preview area.

ows control, click the DOWN spin 
atedly until the clipped pixels 
rom the image.
f the change to Shadows can be seen 
ew area.

e black Exposure Alert button again.

e Alert button turns off.

wnload.

Adjusting images of 

pictures
Book Contents Index

➮

➮

Viewing and removing clipped light areas

You can adjust the light or dark areas to add detail 
back to them.
1 Click , the white Exposure Alert button.

The light areas in the image that will print as 
pure white appear black in the preview area.

2 In the Highlights control, click the UP spin button 
repeatedly until the clipped pixels disappear 
from the image.
The result of the change to Highlights can be 
seen in the preview area.

3 Click , the white Exposure Alert button again.

The Exposure Alert button turns off.

Viewing and

1 Click , th

The dark ar
pure black a

2 In the Shad

button repe
disappear f
The result o
in the previ

3 Click , th

The Exposur
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tput levels

t Levels control in the Exposure 

ol to create interesting effects in 
tures.

r the numbers in the White and Black 
in the Preference Controls tab (see 

tput Levels checkbox in the Exposure 

tool to select it.

nd Black output levels controls 
e Exposure Adjustment tool.
 one side of a slider, 

ent number in the White or Black 

ress Tab or Enter,

 or the DOWN spin button next to the 
ck field.

f the changes to Output Levels can be 
preview area.

wnload.

Adjusting images of 

pictures
Book Contents Index

➮

➮

Setting pixel output levels

The Output Levels control in the Exposure 

Adjustment tool lets you create interesting effects 
for images of pictures.

When you change the White output level value to 0 
and the Black output level value to 255, the colors 
in the image reverse.

Changing ou

Use the Outpu

Adjustment to
images of pic

The ranges fo
fields are set 
page 47).
1 Click the Ou

Adjustment 

The White a
appear in th

2 Click on the

– or –

type a differ
field, then p

– or –

click the UP
White or Bla

The result o
seen in the 

Appearance with
White control = 255
Black control = 0

Appearance with
White control = 0
Black control = 255
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Appearance with
White control = 255
Black control = 0

ith
= 255
 200

Appearance with
White control = 0
Black control = 255

wnload.

Adjusting images of 

pictures
Book Contents Index

➮

➮

If you want to create an image to use as a 
backdrop for dark text on a light background, such 
as an overhead transparency, increase the Black 
output level value until the image is as faint as you 
like.

If you want to create an image to use as a 
backdrop for light text on a dark background, such 
as with color slides, decrease the White output 
level value until the image is as faint as you like.

Click the Auto button in the Exposure 

Adjustment tool to change all the exposure 
settings to the optimal exposure settings 
determined by the scanning software

T I P
Appearance w
White control 
Black control =
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olor balance

Wheel in the Color Adjustment tool to 
balance (hue). 

ndicator circle

ge has too 
olor, move 
ircle toward 
ide 
r) on the 

icator circle 
use, or
’s triangle

f the change 
an be seen 
ew area.

e color for photographs that are 
ve too much of one color.

Indicator circle in
the Color Wheel

wnload.

Adjusting images of 

pictures
Book Contents Index

➮

➮

Adjust color

The scanning software automatically selects the 
optimal color settings for any color output type 
applied to the image. If the overall color in the 
original picture is out of balance, or the picture 
needs more or less color, you can use the Color 

Adjustment tool to increase or decrease:
■ color balance, or hue (see page 80)
■ color saturation (see page 81)

The Color Adjustment tool is active for these output 
types:
■ True Color

■ 256 Color Web Palette

■ 256 Color System Palette

■ 256 Color Optimized Palette

1 From the Tools menu, select Color Adjustment.

The Color Adjustment tool appears (see page 33).
2 Change the color balance or saturation as 

described below.

The color settings you select will be applied to the 
final scan.

Changing c

Use the Color 

change color 

Moving the i

When the ima
much of one c
the indicator c
the opposite s
(opposite colo
Color Wheel.
■ drag the ind

with the mo
■ click a color

The result o
to the hue c
in the previ

Adjust imag
faded or ha

T I P
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olor saturation

t the amount of color in the image 
ation slider control in the Color 

ol. The higher the number in the 
d, the more vivid the colors will be in 
low number in the Saturation field 
ge diluted colors.

 the 
 

d is 

he change to the saturation value 
 the preview area.

e amount of color

umber in the Saturation field to make 
mage more vivid:
 right side of the slider,

r number in the Saturation field, then 
r Enter,

 spin button next to the Saturation 

he amount of color

number in the Saturation field to 
r in the image:

wnload.

Adjusting images of 

pictures
Book Contents Index

➮

➮

To correct the excess red in the picture below, the 
indicator circle can be moved into the cyan area of 
the Color Wheel.

The hue of an image can be changed to create a 
different effect.

Changing c

You can adjus
with the Satur

Adjustment to
Saturation fiel
the image. A 
gives the ima

The range for
number in the
Saturation fiel
0 to 150.

The result of t
can be seen in

Increasing th

Increase the n
colors in the i
■ Click on the

– or –
■ type a highe

press Tab o
– or –

■ click the UP
field.

Decreasing t

Decrease the 
dilute the colo

moved
indicator circle

Very red Less red

moved
indicator circle

Original Special effect

Download from Www.Somanuals.com. All Manuals Search And Do



�

4 HP PrecisionScan Pro User’s Guide 82

e default color settings

to button in the Color Adjustment tool.
al color settings determined by the 

 software are applied to the Color 

t tool.
ts of the changes to the color settings 
en in the preview area.

wnload.

Adjusting images of 

pictures
Book Contents Index

➮

➮

■ Click on the left side of the slider,
– or –

■ type a lower number in the Saturation field, then 
press Tab or Enter,
– or –

■ click the DOWN spin button next to the 
Saturation field.

Applying th

■ Click the Au

• The optim
scanning
Adjustmen

• The resul
can be se

Saturation set at 100

Saturation set at 150

Saturation set at 75
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settings for photographs

guidelines to set output resolution 
ack and white photographs.
e output resolution setting when:

to display the image on a monitor in 
ge
t type is 256 Color Web Palette, 256 

em Palette, 256 Color Optimized 

 Grayscale

he output resolution setting when:
to print the image on a 300 DPI 

t type is True Color, 256 Color 

 Palette, or Grayscale

he output resolution setting when:
to print the image on the 
Smart printer or a 600 DPI printer

ge images, higher resolution does 
 image quality, but does increase 
 of bytes required to store the 

wnload.

Adjusting images of 

pictures
Book Contents Index

➮

➮

Set output resolution

To keep file size small, shorten printing time, and 
use less memory, use the lowest possible output 
resolution setting for an image of a picture.

The output resolution for the image in the 
selection area is set in the Output Resolution tool.

The Output Resolution tool is active for these 
output types:
■ True Color

■ Grayscale

■ 256 Color Web Palette

■ 256 Color System Palette

■ 256 Color Optimized Palette

■ Black & White Bitmap (raster)

1 From the Tools menu, select Output Resolution.

The Output Resolution tool 
appears (see page 27).

2 Read the following sections 
before you change the 
value for output resolution in the Output 

Resolution tool.

The output resolution setting displayed in the 
Output Resolution tool will be applied to the final 
scan.

Resolution 

Follow these 
for color or bl
■ Use 75 as th

• you plan 
a Web pa

• the outpu
Color Syst

Palette, or

■ Use 100 as t
• you plan 

printer
• the outpu

Optimized

■ Use 150 as t
• you plan 

HP Photo

For Web pa
not improve
the number
image.

T I P
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t type is 256 Color Optimized Palette, 
 or Black & White Bitmap (raster)

he output resolution setting when:
to print the image on the 
Smart printer or a 600 DPI printer
t type is 256 Color Optimized Palette, 
 or Black & White Bitmap (raster)

 the output resolution setting when:
to print the image on a 1200 DPI 

t type is 256 Color Optimized Palette, 
 or Black & White Bitmap (raster)

e default resolution

e AutoResolution button in the 
lution tool.
al resolution setting determined by 
ing software is applied to the Output 

 tool.
t of the change to the resolution 
nnot be seen in the preview area.

nge the resolution settings available 
ution tool’s list box (see page 46).

wnload.

Adjusting images of 

pictures
Book Contents Index

➮

➮

• the output type is True Color, 256 Color 

Optimized Palette, or Grayscale

• you will not be enlarging the photograph (use 
a higher resolution if you scale the image to 
greater than 100% of the original’s size)

■ Use 300 as the output resolution setting when:
• you plan to print the image on a 1200 DPI 

printer
• the output type is True Color, 256 Color 

Optimized Palette, or Grayscale

• you will not be enlarging the photograph (use 
a higher resolution if you scale the image to 
greater than 100% of the original’s size)

Resolution settings for drawings

Follow these guidelines for setting output 
resolution for images of color or black and white 
drawings.
■ Use 75 as the output resolution setting when:

• you plan to display the image on a monitor in 
a Web page

• the output type is 256 Color Web Palette, 256 

Color System Palette, 256 Color Optimized 

Palette, Grayscale, or Black & White Bitmap 
(raster)

■ Use 300 as the output resolution setting when:
• you plan to print the image on a 300 DPI 

printer

• the outpu
Grayscale,

■ Use 600 as t
• you plan 

HP Photo
• the outpu

Grayscale,
■ Use 1200 as

• you plan 
printer

• the outpu
Grayscale,

Applying th

■ Click , th
Output Reso

• The optim
the scann
Resolution

• The resul
setting ca

You can cha
in the Resol

T I P
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itmaps

Image of a color
photograph with
the True Color

output type

hite 

) output
ack
eshold

wnload.

Adjusting images of 

pictures
Book Contents Index

➮

➮

Set threshold for black and white b

When you want to save a black and white image 
from a color or black and white photograph, you 
can often improve the result by changing the 
threshold for the division between black and white 
pixels.

The black and white threshold can be changed 
with the Black & White Threshold tool for an image 
that has the Black & White Bitmap (raster) output 
type. (See page 34 for more about the Black & 

White Threshold tool.)

Applying the default threshold

■ Click the Auto button in the Black & White 

Threshold tool.
• The optimal black and white threshold setting 

determined by the scanning software is 
applied to the Black & White Threshold tool.

• The result of the change to the threshold 
setting can be seen in the preview area.

The Black & W

Bitmap (raster

type and a bl
and white thr
of 15 applied
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 the number in the threshold field is 
erence Controls tab (see page 47).

Threshold 127

the Black & White Bitmap (raster)

e

(the default for

old 49

this image)

g the sharpen level to improve 
hen you are changing a color or 
hite photograph to a Black & 

p (raster) image.

wnload.

Adjusting images of 

pictures
Book Contents Index

➮

➮

Changing the black and white threshold

To bring out details in an image with the Black & 

White Bitmap (raster) output type, decrease the 
number in the Black & White Threshold field:
1 Scan a picture.
2 From the Tools menu, select B & W Threshold.

The Black & White Threshold tool appears.
3 From the Output Type menu, select Black & White 

Bitmap (raster).

The image changes to black and white.
4 Decrease the value in the Black & White Threshold 

field:
■ click on the left side of the slider,

– or –
■ drag the slider to the left,

– or –
■ type a lower number in the Black & White 

Threshold field, then press Tab or Enter,
– or –

■ click the DOWN spin button next to the Black & 

White Threshold field.

The result of the change to the black and white 
threshold setting can be seen in the preview area.

The range for
set in the Pref

Image with 
output typ

Thresh

Try changin
the result w
black and w
White Bitma

T I P
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ite bitmaps

or channel from the Scan using 

box in the Black & White Threshold 

 all the red in colored line art or 
ing printed on red or pink paper, 

Red channel. The red components of 
n the image will be mapped to white 
nd blue components of each pixel 
ped to black.
 all the green in colored line art or 
ing printed on green paper, choose 
annel. The green components of 

n the image will be mapped to white 
 blue components of each pixel will 

 to black.
 all the blue in colored line art or 
ing printed on blue paper, choose 
nnel. The blue components of each 
image will be mapped to white and 
en components of each pixel will be 
black.

wnload.

Adjusting images of 

pictures
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➮

➮

Set color channel for black and wh

When you want to save a black and white bitmap 
of a picture that has been printed or photocopied 
on colored paper, or want to create a special 
effect, you can change the color channel used in 
the final scan.

Eliminating a color from the image

By changing the color channel setting in the Black 

& White Threshold tool you can eliminate red, green 
or blue from the image (see page 88).
1 Scan a picture.
2 From the Tools menu, select B & W Threshold.

The Black & White Threshold tool appears.
3 From the Output Type menu, select Black & White 

Bitmap (raster).

The image changes to black and white.
4 Decrease the value for the black and white 

threshold (see page 86).

5 Select a col
channel list 
tool:

■ To eliminate
from a draw
choose the 
each pixel i
and green a
will be map

■ To eliminate
from a draw
the Green ch
each pixel i
and red and
be mapped

■ To eliminate
from a draw
the Blue cha
pixel in the 
red and gre
mapped to 

The Auto button in the Black & White 

Threshold tool does not reset the color 
channel.

T I P
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annel and automatic 
0)

annel and higher 
73)

ray channel in the Scan using 

box of the Black & White 

ol converts color to gray at a 
 red, 59% green, and 11% blue.

wnload.
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pictures
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➮

➮

Examples of changing color channels

Images of a color drawing changed to the Black & 

White Bitmap (raster) output type are shown with 
different color channels and black and white 
threshold settings applied in the Black & White 

Threshold tool.

Original with True Color output 
type

Black & White Bitmap (raster) 
output type applied with NTSC 

Gray color 
channel and 
automatic 
threshold (110)

Red color channel and 
automatic threshold (110)

Green color channel and 
automatic threshold (110)

Blue color ch
threshold (11

Blue color ch
threshold (1

The NTSC G

channel list 
Threshold to
ratio of 30%

T I P
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90 Scan and conve
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r scans the selection area and the 
ea fills the preview area.
election area to include all the 
ou want in the final scan (see 

e final scan and the character 
:
drop to another program (see 
or
e Clipboard (see page 92), or
file (see page 92).

-and-drop or Copy and Paste,
ve to a file.

wnload.
Scanning text Book Contents Index

➮

➮

Scan and convert a block of text

A block of text can be selected in the preview 
image for conversion to editable, unformatted 
text.
1 Preview scan (page 50).
2 From the Output Type menu, select Text as the 

output type.
3 Create a selection area (see page 51).
4 To enlarge the view of the selection area:

• click , the Zoom button in the toolbar, or
• from the Scan menu, choose Zoom.

The scanne
selection ar

5 Adjust the s
characters y
page 55).

6 To begin th
conversion
• drag-and-

page 91), 
• Copy to th
• Save to a 

Original Zoomed imagePreview image Drag
with selection area or Sa
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rop to another program

stination program.
ocument and view the page that will 
 image.
ing software window, position the 

de the selection area.

 changes to .
ft mouse button and drag the image 
on in the open document.

 changes to .
 mouse button.

 of the image is performed.

onverted to editable text and placed 
 document.

eep the original in the same 
 scanner glass until the final 

image is completed.

wnload.
Scanning text Book Contents Index

➮

➮

Drag-and-d

1 Start the de
2 Open the d

receive the
3 In the scann

pointer insi

The pointer
4 Press the le

to its positi

The pointer
5 Release the

A final scan

The text is c
in the open

■ Always Zoom scan a selection area you 
want to convert to text, then adjust the 
position and size of the selection area to 
be sure it contains all the characters you 
want to convert.

■ The text in the selection area is displayed 
at a low resolution and may not appear 
readable, even after a Zoom scan. 

■ During the final scan when you drag-and-
drop, copy, or save the selection area, the 
text will be scanned at a higher resolution 
before it is converted to editable text.

S e l e c t i n g  T e x t

Be sure to k
place on the
scan of the 

T I P

Download from Www.Somanuals.com. All Manuals Search And Do



�

5 HP PrecisionScan Pro User’s Guide 92

e

e Save As... button in the toolbar, or
an menu, select Save As..., or
.

 dialog box appears.

 format choice in the Save as type list 
File (.txt).
in box, choose the directory where 
 save the text file.

ame box, type a name for the text file.

 of the text is performed.

onverted to editable text.

aved to the file.

wnload.
Scanning text Book Contents Index

➮

➮

Copy to the Clipboard

1 Click , the Copy button in the toolbar, or
from the Edit menu select Copy, or
or press Ctrl+C.

A final scan of the image is performed.

The text is converted to editable text.

A copy of the text is placed in the Clipboard.
2 To paste the text in another program’s open 

document:
• Start the destination program.
• Open the document and view the page that 

will receive the text.
• Position the pointer where you want to place 

the text, then click.
• From the program’s Edit menu, choose Paste, 

or press Ctrl+V.

The text appears where you pasted it.

Save to a fil

1 Click , th
from the Sc

press Ctrl+S

The Save As

The only file
box is Text 

2 In the Save 

you want to
3 In the File n

4 Click Save.

A final scan

The text is c

The text is s
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in box, choose the directory where 
 save the file.

ame box, type a name for the file.

 of the entire area of the scanner 
formed.

onverted to editable text.

d images are saved to the .rtf file.
rtf file, open it in a program that can 
h text format files.

F file opened in
other program

wnload.
Scanning text Book Contents Index

➮

➮

Scan a whole page

A entire page of text, or text and pictures, can be 
saved to a rich text format file (.rtf) that contains 
editable, formatted text and images.
1 Preview scan (page 50). 

It is not necessary to create a selection area or 
choose an output type.

2 From the Scan menu, select Save As Whole Page.

The Save As dialog box appears.

The only file format choice in the Save as type list 
box is Rich Text File (.rtf).

3 In the Save 

you want to
4 In the File n

5 Click Save.

A final scan
glass is per

The text is c

The text an
6 To use the .

interpret ric

Original Preview image
with selection area

RT
an
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o the Desktop
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load.
6
➮

➮

Saving sc
images

95 How you can us

96 Print the image

97 Drag-and-drop t

98 Drag-and-drop t

99 Copy to the Clip

100 Save to a file
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ing text, you can convert it to 
t.
nformatted, editable text, see 

rmatted, editable text, see 

wnload.
Saving scanned images Book Contents Index

➮

➮

How you can use the image

When you have scanned a picture and are 
satisfied with the image in the selection area, 
there are several ways to use the image.
■ Print the image from the scanning software (see 

page 96).

Printing the image from the scanning software 
results in a hardcopy of the image, but does not 
save it to the hard disk.

■ Make the image permanent by placing it directly 
from the scanning software into another 
program. When you save the document you 
placed the image in, the image is saved with the 
document.

You can place the image directly into another 
program using:
• drag-and-drop (see page 97)
• copy and paste (see page 99)
• TWAIN (see page 11)

■ Make the image permanent by saving it to a file. 

An image file can be created using:
• drag-and-drop to the Desktop (see page 98)
• the Save As... command (see page 100)

When scann
editable tex
■ To save u

page 90.
■ To save fo

page 93.

T I P
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ction area has been drawn, the 
a of the scanner glass is printed.
 keep the original in the same 

the scanner glass until the final 
e image is completed.

wnload.
Saving scanned images Book Contents Index

➮

➮

Print the image

1 Click , the Print button in the toolbar, or 
from the Scan menu, select Print,
or, press Ctrl+P.

The Print dialog box appears.
2 Fill out the options in the Print dialog box.
3 Click OK.

A final scan of the image is performed.

The image is sent to the printer.

When you print a copy of the image in the 
selection area you will be able to see the size 
and quality of the printed image.

Use the Print command to send a copy of the 
image to a printer. 

■ If no sele
entire are

■ Be sure to
place on 
scan of th

T I P
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eep the original in the same 
 scanner glass until the final 

image is completed.

wnload.
Saving scanned images Book Contents Index

➮

➮

Drag-and-drop to another program

1 Start the destination program.
2 Open the document and view the page that will 

receive the image.
3 In the scanning software window, position the 

pointer inside the selection area.

The pointer changes to .
4 Press the left mouse button and drag the image 

to its position in the open document.

The pointer changes to .

(If the pointer changes to , the destination 
program does not accept drag-and-drop.)

5 Release the mouse button.

A final scan of the image is performed.

The image appears in the destination program.

The image in the selection area can be 
dragged and dropped into another program 
that supports drag-and-drop. 

After the image is dropped into the destination 
program, the image becomes part of the 
document file.

Be sure to k
place on the
scan of the 

T I P
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 keep the original in the same 
the scanner glass until the final 
e image is completed.
 running Internet Explorer, only 
p file named Scan.bmp can exist 

r.
he Scan.bmp file with a name 
ts what image is in the file.

wnload.
Saving scanned images Book Contents Index

➮

➮

Drag-and-drop to the Desktop

1 In the scanning software window, position the 
pointer inside the selection area.

The pointer changes to .
2 Hold the Ctrl key down, press the left mouse 

button, then drag the selection area to the 
Desktop or to a folder in the Windows Explorer.

The pointer changes to .

3 Release the mouse button.

A final scan of the image is performed.

A bitmap file named Scan.bmp is created on the 
Desktop or in the folder in the Windows Explorer.

You can create a bitmap file of the image in 
the selection area by dragging the selection 
area to the Desktop or to a folder in the 
Windows Explorer. 

The file name for each new bitmap file after 
the first one created this way includes a 
number in parentheses.

■ Be sure to
place on 
scan of th

■ If you are
one bitma
in a folde

■ Rename t
that reflec

T I P
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 image

stination program.
ocument and view the page that will 
 image.
 pointer where you want to place the 
 click.
ogram’s Edit menu, choose Paste, or 
.

appears where you pasted it.

wnload.
Saving scanned images Book Contents Index

➮

➮

Copy to the Clipboard

Copying the image

1 Create a selection area (see page 51).

2 Click , the Copy button in the toolbar, or
from the Edit menu select Copy, or
or press Ctrl+C.

A final scan of the image is performed.

A copy of the image is placed in the Clipboard.

Pasting the

1 Start the de
2 Open the d

receive the
3 Position the

image, then
4 From the pr

press Ctrl+V

The image 

The image in the selection area can be copied 
to the Clipboard, then pasted into the 
destination program. After the image is pasted 
into the destination program, the image 
becomes part of the document file.

Be sure to keep the original in the same 
place on the scanner glass until the final 
scan of the image is completed.

T I P
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e (.bmp)

 format used by Microsoft Windows 
ndows programs. This is often a 
ecause Windows itself and most 

grams accept the .bmp file type.

x)

 contains a complete image plus 
 resolution copies of that image. The 
the FlashPix file format over other 
 that a software program can 
 select the best resolution for a 
to make editing and using images in 
ter and easier.

wnload.
Saving scanned images Book Contents Index

➮

➮

Save to a file

File formats

The scanning software can save images in several 
graphics file formats.

Bitmap Imag

An image file
and many Wi
good choice b
Windows pro

FlashPix (.fp

A FlashPix file
several lower
advantage of 
file formats is
automatically
particular job 
programs fas

The image in the selection area can be saved to 
a file, then the image file can be inserted into 
another program’s document with an Insert File 
or Import File command.

You will need to know what file format to use 
when saving the file.

Not all output types can be saved in all file 
formats. Only the valid file formats for the 
output type applied to the image can be 
selected from the Save as type list box in the 
Save As dialog box.

T I P
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aphic (also called a raster graphic) 
y resolution. TIFF image files can be 
ple platforms.

ssed (.tif)

IFF files for images are smaller than 
e files. Images with the Black & White 

 output type are compressed with 
ression. All other output types are 
ith LZW compression.

.pcx)

rmat is for images used in Windows 
h as PC Paintbrush and Paint.

 (.rtf)

 File file format is used with the Save 

... command to create an RTF file of a 
tains text or text and pictures. The 
text in an RTF file can usually be 
 other programs.

tafile (.wmf)

 Windows Metafile file format is 
ble (vector) images in Windows 
e .wmf file format is available for 
n the Black & White Scalable (vector) 
 applied to a selection area that 
wing.

wnload.
Saving scanned images Book Contents Index

➮

➮

GIF Image (.gif)

GIF is a compressed file format suitable for an 
image that will be used on the Web or on multiple 
platforms.

JPEG Image (.jpg)

JPEG is a compressed file format for images. Its 
strengths are small file sizes and speed. The trade-
off for these advantages, though, is reduced 
image quality. Since each time an image is 
compressed with JPEG it loses a little of the image 
data, avoid compressing a file with JPEG more 
than once. JPEG is an appropriate file format for 
an image that will be used on the Web or on 
multiple platforms.

Text File (.txt)

The Text File file format is used for saving to a .txt 
file when: 
■ the selection area contains only text
■ the Text output type is applied
■ you want the text converted to editable, 

unformatted, ASCII text

TIFF Image (.tif)

TIFF is an industry-standard image file format. 
TIFF files are usually created by scanners and are 
widely accepted by programs that work with 
photographs and other images. A TIFF file is a 

bitmapped gr
and can be an
used on multi

TIFF Compre

Compressed T
the TIFF Imag
Bitmap (raster)

PackBits comp
compressed w

PCX Image (

The PCX file fo
programs suc

Rich Text File

The Rich Text
As Whole Page

page that con
formatting of 
interpreted by

Windows Me

The Microsoft
used for scala
programs. Th
drawings whe
output type is
contains a dra
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le size

e the size of an image file in the 
ware by:
solution
e True Color output type
e scale of the image
 a compressed file format (.gif, .jpg, 
ressed)

wnload.
Saving scanned images Book Contents Index

➮

➮

Saving the file

1 Click , the Save As... button in the toolbar, or
from the Scan menu, select Save As..., or
press Ctrl+S.

The Save As dialog box appears.
2 In the Save in box, choose the directory where 

you want to save the file.
3 In the File name box, type a name for the image 

file.
4 From the Save as type list box, choose a file type.
5 Click Save.

A final scan of the image is performed.

The image is saved to the file.

The file name extension for the selected file type 
is automatically added to the file name.

Reducing fi

You can reduc
scanning soft
■ reducing re
■ avoiding th
■ reducing th
■ saving with

or .tif comp

Be sure to keep the original in the same 
place on the scanner glass until the final 
scan of the image is completed.

T I P
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➮

➮

The 35mm slide adapter

The HP ScanJet slide adapter can be used to scan 
35mm mounted slide photographs. 

Placing the slide and the adapter

1 Lift the scanner lid so that it stays up.
2 Place the adapter next to the top edge of the 

scanner glass so that the arrowhead on the 
adapter points to the arrowhead on the scanner 
bed.

3 Tip the adapter toward the scanner lid.
4 Turn the slide so the emulsion side is next to the 

scanner glass.
5 Orient the slide with the top of the picture 

directed to the top edge of the scanner glass.
6 Place the slide under the notched section of the 

adapter.
7 Lower the adapter onto the scanner glass.
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eep the slide in the same place 
ner glass until the final scan of 
s completed.

 of the 
ea

wnload.
Scanning 35mm slides Book Contents Index

➮

➮

Scan the slide

1 Preview scan (page 50).
2 Create a selection area of the part of the image 

you want in the final scan (page 51).
3 Zoom scan (page 56).
4 Set the output dimensions (page 58).
5 If necessary, make adjustments to the image 

(see Chapter 4 Adjusting images of pictures 

page 65).
6 Save, copy, drag-and-drop, or print (see 

Chapter 6 Saving scanned images page 94).

A Preview scan of the slide

Be sure to k
on the scan
the image i

T I P
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alable 
 type 17

reshold 
7, 88

47

7

) 67

87, 88

7

r) 67

, 88

el 88

, 73

button, Scan
configuring 12

using 10, 50

C
Clear Selection 

command 16

clip art, Black & White 
Scalable (vector) 
output type 17

Clipboard, copying an 
image to 99

color
automatic application 

45

balance 33, 80

Color Wheel 80

wnload.
Book Contents

➮

➮

Index
A
acquiring with TWAIN 11

adjustments 66

and output type 66

black and white 
threshold 85, 86, 88

color balance 80

color channel 87, 88

color saturation 80

exposure 32, 70

highlights 32, 70

hue 80

midtones 73

output levels 78

resolution 27, 83

shadows 32, 70

sharpening 68

automatic
color 45

exposure 45

output type 45

selection area 45

AutoResolution 27

B
backgrounds, creating 

79

Best Quality
Scaling 43

Sharpening 43

bitmap file format 100

Black & White Bitmap 
(raster) output type 17

Black & White Sc
(vector) output

Black & White Th
tool 34, 85, 86, 8
control range 

preferences 
black and white

adjustments 6
bitmap (raster
color channel 
output types 6
scalable (vecto

black and white 
threshold 85, 86

Blue color chann
.bmp 100

brightness 71, 72
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55) 47

blue 87, 

0

lication 

ment 

47, 71

ters 25

to 98, 

92

age 93

file format
bitmap 100

FlashPix 100

GIF 101

JPEG 101

PCX 101

Rich Text File 101

Text File 101

TIFF 101

TIFF Compressed 101

Windows bitmap 100

Windows Metafile 101

final scan 26, 49

pictures 102

text 90

TWAIN 11

whole page 93

FlashPix file format 100

.fpx 100

fuzzy images 58

G
gamma, setting 70, 73

.gif 101

GIF file format 101

Grayscale output type 17

adjustments 67

Green color channel 88

wnload.
Book Contents

➮

➮

eliminating red, 
green, or blue 87, 88

output types 17

output types, 
adjustments 66

saturation 33, 80, 81

vivid 81

Color Adjustment tool 
33, 80

color channel 87, 88

Color Wheel, using 33, 80

colored paper, 
minimizing effect 87

commands
in menus 15

in toolbar 20

context-sensitive 
pointers 24, 25

Controls tab in 
Preferences 47

controls, resetting
Black & White 

Threshold 34, 85

Color Adjustment 33

Exposure Adjustment 
32, 70

Output Resolution 27, 
84

Sharpen Level 29, 69

Copy command 16, 20, 99

copying to the Clipboard 
99

D
deleting settings 40

detail, eliminating 76

detail, enhancing 76, 77

black and white 86

highlights 71

shadows 72

sharpening 68

dimensions 30, 60, 61

locking output 61

Dimensions tool 30, 58

displaying images 63, 64

docking a tool 26

drag-and-drop
pointers 24

to another program 97

to the Desktop 98

drawings
output types for 84

resolution 84

resolution for 28

E
Edit menu 16

8-bit readout (0-2
eliminating

details 76

red, green, or 
88

exposure
adjusting 32, 7
automatic app

45

defaults 70

Exposure Adjust
tool 32, 70

control range 
preferences 

histogram 74

RGB Meter 75

eyedropper poin

F
file

formats 100

saving image 
100, 102

saving text to 
saving whole p
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 101

mmand 

40

epth 43

7

73

lor 63

 

g 35

online manuals 37

optimized palette 63

output dimensions 30, 58

output levels for pixels 
78

output resolution 27, 83

Output Resolution tool 
27, 83

adding or deleting 
values 46

AutoResolution 27

output type
and adjustments 66

automatic application 
45

changing 63

choosing 62

for clip art 17

suggestions for 
choosing 64

Output Type menu 17

P
.pcx 101

PCX file format 101

photographs
output types for 62, 83

resolution 83

wnload.
Book Contents

➮

➮

H
Help

HP ScanJet Coach 36

menu 19

online manuals 37

Show Me 36

status bar 35

ToolTips 35

using 35

videos 36

What’s This Help 35

highlights 32, 70, 71

histogram
Black & White 

Threshold tool 34

Exposure Adjustment 
tool 32, 74

HP PrecisionScan Pro
Edit menu 16

Help menu 19

info bar 22

menus 15

Output Type menu 17

pointers 24

Preferences dialog 
box 41

Scan menu 15

status bar 23

toolbar 20

Tools menu 18

View menu 16

window 14

HP ScanJet Button 
Manager 12

HP ScanJet Coach 36

HP scanner support 3
hue 33, 80

I
images

acquiring with TWAIN 
11

copying 99

drag-and-drop 97, 98

output dimensions 58

printing 96

resolution 27, 83

saving 98, 100

scaling 60

straightening 9
using 95

info bar 14, 16, 22

J
jagged images 58

JPEG file format
.jpg 101

L
Load Settings co

15

loading settings 

M
Maximum Pixel D
menus

Edit 16

Help 19

Output Type 1
Scan 15

Tools 18

View 16

midtones 32, 70, 
monitors, 256 co

N
NTSC Gray color

channel 88

O
online Help, usin
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01

 33, 80

d 15, 20

age 
3

mmand 

 100, 102

canner

el 87, 88

anager 

HP support 3
placing original 9

scanner Scan button
configuring 12

using 10, 50

Scanner tab in 
Preferences 42

scanning
basic steps 49

starting scanning 
software 10, 11

Select All command 16

selection area
adjusting 55

automatic creation 45

creating 51

move pointer 24

pointers 24

resize pointers 24

zooming 21, 56

Selection Area tab in 
Preferences 44

settings
deleting 40

loading 40

saving 39

shadows 32, 70, 72

Sharpen Level tool 29, 68

wnload.
Book Contents

➮

➮

pictures
output types for 62

pixel value pointers 25

pixels
output levels 78

preferences 43

Place Image command 
11, 15

placing original 9
pointers 24, 25

Preferences 41

color adjustment 45

command 15

Controls tab 47

exposure adjustment 
45

output type change 45

pixel depth 43

Resolution tab 46

scaling 43

Scanner tab 42

selection area 45

Selection Area tab 44

preview area 14, 21

enlarging 21

selecting 54

Preview command 15, 20

preview image 10, 14

returning to 57

Preview scan 10, 50

Print command 15, 20

Print Setup command 15

printer resolution 28

printing images 28, 96

R
Red color channel 88

reset controls
Black & White 

Threshold 34, 85

Color Adjustment 33

Exposure Adjustment 
32, 70

Output Resolution 27, 
84

Sharpen Level 29, 69

Reset Controls 
command 18, 20

resize
image dimensions 30, 

58, 60

selection area 30, 55

resolution 27, 83

adding or deleting 
defaults 46

preferences 46

setting 27, 83

Resolution tab in
Preferences 46

RGB Meter 75

Rich Text File 101

rotating image 9
.rtf 93, 101

RTF file format 1

S
saturation, color
Save As comman
Save As Whole P

command 15, 9
Save Settings co

15

saving
settings 39

to a file 92, 93,
scaling 30, 60

preferences 43

Scan button on s
configuring 12

using 10, 50

Scan menu 15

scan using chann
ScanJet Button M

50

scanner
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U
Undo Zoom command 

16, 20, 57

unformatted text 90

URL for HP scanner 
support 3

V
videos 36

View menu 16

W
What’s This Help 35

pointer 25

window, HP 
PrecisionScan Pro 14, 
15

Windows
bitmap 100

Metafile file format 101

.wmf 101

Z
Zoom command 15, 20

undoing zooms 57

Zoom scan 21, 56

wnload.
Book Contents

➮

➮

sharpening 29, 68

preferences 43

Show Me videos 36

size
output image 30, 58, 60

selection area 30, 58

slides
creating background 

for 79

scanning 105

special effects 78, 79, 81, 
87

starting scanning 
software 10, 11

status bar 16, 23

straightening image 9
support, for scanner 3

T
10-bit readout (0-1023) 

47

Text File file format 101

Text output type 17, 90

text, editable
formatted 93, 101

unformatted 90, 101

35mm slides

creating background 
for 79

scanning 105

thresholding 34, 85, 86, 
88

.tif 101

TIFF Compressed 101

TIFF file format 101

tonal resolution 47

toolbar 16, 20

tools
Black & White 

Threshold 34, 85, 86, 
87, 88

Color Adjustment 33, 
80

descriptions 26

Dimensions 30, 58

docking 26

Exposure Adjustment 
32, 70

Output Resolution 27, 
83

Sharpen Level 29, 68

Tools menu 18

ToolTips 35

True Color output type 
17

turning off

automatic colo
automatic exp
automatic outp

45

automatic sele
area 45

Best Quality S
43

Best Quality 
Sharpening 

Maximum Pixe
43

TWAIN 11

12-bit readout (0
47

256 Color
Optimized Pale

output type 
System Palette

type 17

Web Palette ou
type 17

256-color display
monitors 63

.txt 92, 101

typing pointer 25
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